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WARRANTY 9(b)

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the media will be free
from defects in materials and workmanship for a period of three (3) months from the date of shipment. If any such medium or encoding
proves defective during the warranty period, Tektronix will provide a replacement in exchange for the defective medium. Except as to the
media on which this software product is furnished, this software product is provided “as is” without warranty of any kind, either express or
implied. Tektronix does not warrant that the functions contained in this software product will meet Customer’s requirements or that the
operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period. If
Tektronix is unable to provide a replacement that is free from defects in materials and workmanship within a reasonable time thereafter,
Customer may terminate the license for this software product and return this software product and any associated materials for credit or
refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND
CUSTOMER’S PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS
WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE
POSSIBILITY OF SUCH DAMAGES.






Table of Contents

Table of Contents

General Safety SUMMaArY . ... ... i
PrOfaCE . . o e i
Key FoatUrES . . oo e i
DOCUMENTALION . . . . oot e e e e e i
Software Upgrades . . ... ..ot iv
Contacting TEKIrONIX . . . . ..ot e iv
Install the SOftWare . .. ... .. o 1
Before Installation . . . .. ... ... 1
InStallation . . . ... e 1
Connect 10 the OSCIlIOSCOPE . . . . . oottt e e e e e e 1
Start the Software . . ... ... 2
Close the SOMWArE . . ... ... e e e e e e e 4

Get Acquainted with the Software . . . ... . 5
Usethe Interface . . ... ... i 5
Virtual Keyboard . ... ... o 5

Virtual Keypad . . . .. oo e 6

General Purpose Knob . . . .. ..o o e 7

SOt PO OIENCES . . o 7
Hide and Return the TDSHT3 Software . .. ... ...t e 8

Use the TDSHT3 SOftWare . . ... ... e et et et e e 9
Tests: Process FIOW . . ... e 9
SElBCE @ TS . .ot 9
Configure the Test Parameters . . . . ... ...ttt e e e 10
Connect and Configure the Equipment . . .. ... ... 10
View the Wavelorm . . . ... e 1

RUN e Test . . e 1
Interpret the Test ResUlt . . ... ... o e 12
Generate and Print a Report . . .. ... o 14
UMY . ..t e e e e 14

DAl . .. 15
Application EXampIes . . . . . oo 18
Source: Select All (Clock-Data Tests) . . ... ..o oo 18
Source: Inter-Pair Skew (Data-Data Tests) ... ........coouiiii 21
Sink: Min-Diff Sensitivity Test . . . . . . ..o 24
Sink: Jitter Tolerance Test . . .. ... oot 26
Cable: Eye Diagram Test . . . . . ..ottt e 29
Enable Remote Control of Test Equipment . ... ... ... . o 32
Install NI-488.2 for WINdOWS . . . .. ..o e e e 32

Connect the EQUIPMENE . . . . ... o e 33

Verify the Equipment CONNECLIONS . . . . . .. ..ottt e e 33

Setthe GPIBBUS TIMING . . . . ..ottt et et e e e e et et e 34
Configure the GPIB AdArESS . . . . . . oot et e et e e e e e e e 34

O o e e 36

TDSHT3 HDMI Compliance Test Software Quick Start User Manual i



General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.
While using this product, you may need to access other parts of the system. Read the General Safety Summary in other
system manuals for warnings and cautions related to operating the system.
To Avoid Fire or Personal Injury

Connect and Disconnect Properly. Connect the probe output to the measurement instrument before connecting the
probe to the circuit under test. Disconnect the probe input and the probe ground from the circuit under test before
disconnecting the probe from the measurement instrument.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.
Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this product, have it inspected by
qualified service personnel.

Do Not Operate in Wet/Damp Conditions.
Do Note Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

i TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Preface

Preface

The TDSHT3 HDMI Compliance Test Software is a High Definition Multimedia Interface (HDMI) Compliance Test Solution,
which runs on a Tektronix oscilloscope. This software helps you perform HDMI physical layer validation and compliance
testing.

Key Features

Conformance to HDMI 1.0 standards and test specifications (CTS version 1.1) ensures reliable results
Complete validation to standards with wide range of tests for source, sink, and cable devices
Accurate source tests using precise measurement techniques

Dependable sink tests with closed-loop measurements that eliminate nonlinearities in test setup
Automated sink and cable tests with remote control of signal sources

Automatic mask fit, measurements, and pass or fail notification

In-depth analysis with statistical analysis and mask margins

One-button selection of multiple tests

One-button csv-format summary and reports

Complete compliance solution with an elaborate test fixture, signal sources, and TDR

Documentation

This manual describes the installation and basic operation of the TSDHT3 software. For more detailed information, see the
online help. The following information is available for this product:

TDSHT3 Online Help

Start > Programs > TekApplications > TDSHT3 > Help

TDSHTS Online Help (PDF)

| | =~ + @‘
TDSHT3 Quick Start User Manual, English (PDF)

TDSHT3 Quick Start User Manual, Japanese (PDF)
TDSHT3 Quick Reference Card, Source Test (PDF)
TDSHT3 Quick Reference Card, Sink Test (PDF)

(Documents folder)

C:\TekApplications\TDSHT3\Manuals WWw.Tektronix.com

Installation Manual: Optional Application Software on
Windows-Based Oscilloscopes
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Preface

Software Upgrades

Periodic software upgrades may become available. Note that the software is only operational if you have a valid option key

for the specific oscilloscope model and serial number.

To check for upgrades:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Select Software and Drivers.

3. Enter the product name (TDSHT3).

Contact Tektronix

Phone 1-800-833-9200 !

Address

Web site

Sales support
Service support
Technical support

Tektronix, Inc.

14200 SW Karl Braun Drive
P.0. Box 500

Beaverton, OR 97077

USA

www.tektronix.com
1-800-833-9200, select option 1
1-800-833-9200, select option 2 !
Email: techsupport@tektronix.com

1-800-833-9200, select option 3 1
6:00 a.m. - 5:00 p.m. Pacific time

1 This phone number is toll free in North America. After office hours, please leave a voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the Tektronix Web site for a list of offices.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Install the Software

Install the Software

The TDSHTS3 software must be installed on a Tektronix oscilloscope. The following models are supported:
= TDS7704B
= TDS7404/B
= (CSA7404/B
= TDS7254/B
= TDS6604B
= TDS6804B
= TDS6124C

= TDS6154C

Before Installation

= TekVisa must be installed on the oscilloscope. If you do not have TekVisa, you can download it from the Tektronix Web
site, in the same location as for Software Upgrades (see page iv).

= Please read the Readme.ixt file on the product software CD before you install the software.

Installation

1. Close all applications.
2. Insert the product software CD into the CD drive of the oscilloscope.

3. The installation wizard will guide you through the installation. If this is a version upgrade, the existing software will be
automatically removed before the new version is installed.

4. The software files will be installed at C:\Program Files\TekApplications\TDSHT3.

Connect to the Oscilloscope

The various tests require specific equipment setups and specific test adapters. Click More within the connect pane to see
how to connect the device under test and test equipment to your oscilloscope. The following test adapters are required:

Tektronix HDMI TPA-P-DI (for Differential Source tests)

Tektronix HDMI TPA-P-SE (for Single-Ended Source tests)

Tektronix HDMI TPA-P-TDR (for TDR tests)

Tektronix HDMI TPA-R-DI (for Cable tests and Sink tests)

Tektronix HDMI TPA-R-SE (for Cable tests and Sink tests)

Tektronix HDMI TPA-R-TDR (for TDR tests and Sink tests)

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 1



Install the Software

Start the Software

To start supported 7000-series oscillo-
scopes:

1. From the oscilloscope menu, select
File > Run application > HDMI Com-
pliance Test Software.

2. The oscilloscope display resizes to fit
in the upper part of the screen.

3. The software displays in the lower part
of the screen.

4. Proceed to step 5.

To start supported B/C-series oscillo-
scopes:

1. Select App > HDMI Compliance Test
Software.

File  Edi Werkical Horiz/Acq Trig Displa ors Measure  Masks Math Utilities Help

Reference Waveforms 3

Instrument Setup...
Recall Default Setup

Run Application

USE2.0 Test Package
Page Setup...

Prink Previev
Print... Chrl+p

Export Setup...
Select for Export 3
Export...

1 Recent Setup Fle 1

Minimize Chrl+M

Shutdown...

File Edit Werkical Horiz/Acq Trig Display Cursors Measure  Masks Math Utilities Help

Position

Factor

B

TDSHT3

- =
Cable Run
Data-Data Tests Single-Ended Tests Test
ye Diag . .Int»‘:r—F‘a\r Shee -Imrs-F's ket
Configure Result

Summary
Datail

Select All

Clock-* Ch1: Data-* Ch2; Rec Length-> BM; CRU-> PLL

Source -> Eye Diagram

File Edit Verical

Horiztdcq Trig Display Cursors Measure Masks Math  App UHilties Help Buttons
USBZ.0 Test Package
HDMI Compliance Test Software
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Install the Software

The oscilloscope display resizes to fit
in the upper part of the screen.

The software displays in the lower part
of the screen.

Proceed to step 5.

Measure Masks Math App Utilities Help Buth
21 Jun

Selast - Source
Cable

Data-Data Tests

NOTE. To ensure accurate results, calibrate the probes and the oscilloscope before you run tests.

Click Utilities > Instrument Calibra- Fe  Edt
tion to begin calibrating the oscillo-

scope for signal path compensation.
Click Calibrate.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual

Werkical Horiz/Acq Trig Display

Cursors  Measure  Masks  Math | Liiities  Help

Sample Tek Secure Erase...

Set Time & Date...

iaPIE Configuration, ..
LAN Server Status...
External Signal:

Instrurment Diagnostics. ..

Dieassign Multipurpose Knobs

User Preferences. .,

©ption Installation. ..

Calibration Instructions

Status
up

Calibrate



Install the Software

7. Select Vertical > Probe Cal to begin
calibrating the probes.

8. Connect the probe calibration signal to
the probe.

9. Click Calibrate Probe.

Close the Software

1. Select File > Exit.
2. You can also click the exit icon.

Using other methods to exit the software
will result in abnormal termination.

3. When you exit the software, you can
restore the oscilloscope to the settings
that were in place before the TDSHT3
software changed them.

File Tests Results Utilities Help TDSHT3

I S 2 Diagram . .Inb‘:r—F‘ . -Fair Ske
Recall Recent » Result

Preferences b R

Souree -> Eye Diagram

File Edit Vertical Horizfacg Trig Display Cursors Measure  Masks  Math Ltilities Help

<> &=

Position

Vertical Setup... L4s 21.Jun 04 11
Zoom Contrals. .,

Display OnjOfF. ..
PasitionfScale...

Label...
Factor

Offset... 5
Termination. ..

Coupling. ..
Bandwid

Deskew,
Attenuation. ..

Zoom Setup...
Zoom Graticule Size  »

File Edit Werkical Horiz/Acq Trig Display Cursors Measure  Masks Math Utilities Help

21 Jun 04

A, _‘.-M.-fuw\
T

Factor

wnww--q
|

—

i

alpdins
{

Clear Probecal

b 1 | 1 |-+ Calibrate Probe
i ngaytel Yottty

Chl SO0k 2 Ch2 20 2 IT 10

Recall Default

- ce
Cable Run
Data-Data Tests Single-Ended Tests Test

Recall Clock-Data Tests

Save...

Minimize

i awatorm &r Select Al

Clock-» Chi; Data-= ChZ; Rec Length -> 1M, CRU -> PLL

Summary
Detail

Do you want to restore the oscilloscope seftings to
their state prior to starting this application?
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Get Acquainted with the Software

Get Acquainted with the Software

Use the Interface
Use a keyboard, mouse, or touchscreen to make selections in the TDSHT3 software.

Use menus, check boxes, and on-screen buttons to control the software functions. Use Microsoft Windows techniques to
navigate menus and select or clear check boxes.

Device under test (DUT) type Client pane Execution pane

Menu bar “le Tests Results Utiiies Hep TDSHT3 B x|

Differential Tests ¢ Single-Ended Tests

itivity - Jittar Tolerance Intra-F air Shew

Rezult
Selection pane Report—,

Wiewn
i avetorm

Status bar ok - Intra-Pair Skew Clack-= Ch1; Thit: Recals; Awgs-> 100
Virtual Keyboard
1. Click a keyboard icon. File Tests Results Utiities Help TDSHT3 m x|

Configure - Sink

setact Fun
== Test

Datal

Pattern Path Era— -
o R It
anfigure Ca ioationd] =
Data2 Report—
—

Wiy
Wi aveform

Sink -> Min-Diff Sensitivity Input-= Ch1; Wiem -> 2.0V

2. Clear the existing text and type the

DTG Pagges Path
neW teXt. Eo ¢ CaTekApplicationATDSHTAP attemnATES T2-6 DiffSensitivity
3. Click Enter to confirm your selection. - i I -
[T K

< = 2

NOTE. You must click Enter on the virtual keyboard, otherwise your selections are not valid.
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Get Acquainted with the Software

Virtual Keypad

1. Click any number box. File Tests Results Utiliies TDSHT3 m x|

Confiqure - Source

H H Input Horizificq Reference Levels Run
Click the keypad icon. o \] =N e -
& Abs

Configurs
chz ¥ Reclengty ; - Report—
Mo

b

Chi W

Connest .,

CRU
Wi
Wi aveform

Clock-» Ch1; Data-» Ch2; Rec Length -= 10; CRU .= PLL

Source = Multiple Tests

3. Clear existing value and enter the de-
sired value.

4. Select a unit of measure.

5. Click Enter to confirm your selection.

NOTE. You must click Enter on the virtual keypad; otherwise your selections are not valid.

6 TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Get Acquainted with the Software

General Purpose Knob

1. C“Ck any number box to dISplay the File Tests Resulis Utilities Help TDSHT3 L
connegtion to one of the general pur- Canfiqure - Saurce

Horizieq Reference Levels
pOSG knObS #of Acgs  ® Units: High . Test
{3

Se
Hysteresis J' Mid

® Report—

Ch2

Wiy
Wi aveform
>

Source -> Eye Diagram Clack-> Ch

2. Turn the corresponding knob on the (
oscilloscope front panel to adjust the
value for the selected parameter.

]
0/0
0
‘0
0

om om 00

© mi0®

D
o

000
00
00

3. For better resolution, press the FINE
button.

5]
_ 0
)
0
)
0
)
0

&
(e 0c00]g @ @ B - |
J CJ

Set Preferences

1. From the TDSHT3 software menu bar, File Tests Results Utilies Help
click File > Preferences, and then se- Recall Defaul y ke,

Iect an Optlon. el al Tests Single-Ended Tests

un
@
Save
Jitter Talerance Intra-Fa eI
Result

2. Click t_he option again to clear the Fosilon Eye ack n Certer —
Se|eCtI0n. i Acquisition Alert Message

TOSHT3 By (x|

Recall Recent »

Summary

Sink -> Min-Diff Sensitivity Input-> Ch1; Wiem > 3.00;

Option Description

Position Eye Mask in Center Selected: Positions the mask at the center of the eye diagram.
Cleared: Positions the mask to the left of the eye diagram.

Acquisition Alert Message Selected: An alert prompts you to specify oscilloscope settings with
which to run the test.
Cleared: TDSHT3 software selects oscilloscope settings.

Trigger These tests can be run with a width trigger or an edge trigger
Rise/Fall Time or Over/Undershoot (default). If the signal has very high intersymbol interference (ISI),
(Available for B/C-series oscilloscopes only) use the width trigger.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 7



Get Acquainted with the Software

Hide and Return the TDSHT3 Software

1. Click the hide icon to minimize the @
TDSHT3 software and enlarge the os-
cilloscope display.

File Tests Results Utiliies Help TDSHT3 ;|| X%

Configure - Source

HoriziAcq Reference Levels Run
#of Acqs L Units High Test

J L3
i -
B

i —I
Summary
Detall

To return to the TDSHT3 software:

Source -> Multiple Tests Clock-= Ch1; Data-» ChZ; Rec Length -> 104, CRU - PLL; High -> 20%; Lo > 20%

2. For 7000-Ser|es OSC|IIOSCOpeS, Select File  Edit  Wertical  Horizgfacg  Trig  Display  Cursors  Measure  Masks  Math  Ubiities  Help
the APP button.

3. For 6000B/C and 7000/B-series oscillo-

- :
scopes, select App > Restore Ap- e

plication. HDMI Compliance Test Software

8 TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Use the HDMI Software

Use the TDSHT3 Software

Tests: Process Flow

When you make a test, follow the sequence of actions indicated in steps 1 through 6. Details for each of these actions are
given on the following pages.

1. Select a test. @ @

2. Configure the test parameters. T =
3. Connect and configure the equipment. --S""ﬁf"f"“'“"mests R
4. View the waveform to verify test signal. @ v Bl

5. Run the test.

6. [Interpret the test result. @

1.

Generate a report.

NOTE. For accurate test results, calibrate the oscilloscope and probes before you begin the tests. See page 3.

Select a Test

1. Click Select. @ @ @
2. Click the Source, Sink, or Cable tab.
File Tests Results| Utilities Hel) TDSHT3 EJ LI
3. Move the mouse near a test name until - —]———— Selec§ =
the test ID appears. This ID corre- i D

sponds to the Test ID in the HDMI - v/ Ws- H
Compliance Test Specifications. fude Report—

Connest \
wisw I— .
Wiavaform all Time L=t

Source -» Clock Jitter Clock-> Chi; Rec Length -= 1M; CRU-> PLL

4. Select the test that you want to run.

You can select multiple tests, but they
must all be of the same type.

5. To select all tests of a certain type,
click Select All.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 9



Use the HDMI Software

Configure the Test Parameters

1. Click Configure. File Tests Results Utiities Help TDSHT3 | x|

Confiqure - Source
2. Use the virtual keyboard or the general o o e rencetenee
purpose knob on the oscilloscope front - G ¢ -
. Configure Result
panel to change the values if neces- Rec Length ptoresic |3 B —

Chz _..
p how G 50%
sary s 6

You can also use the File menu to
restore factory defaults or save and
recall your own configuration seftings.

Source -> Eye Diagram Clock-> Chi; Data-» Ch2; Rec Length -> 1M; CRU > PLL

Connect and Configure the Equipment

10

NOTE. If your test uses remote control, the setup diagram in the online help shows how to connect the test equipment by
using an E-net connection. You can either use this method or you can use the GPIB-B connection described on
pages 32 through 35 of this document. Example tests are shown in the Application Examples section, starting on page 18.

1. Click Connect. @ @
2.

Follow the on-screen instructions to File Tests Results Ufliies Halp TDSHI3 m x|
connect and configure the device un- &, netruc e tione,
der test and the test equipment. =

3. Click More to view the online help for o : tures and probes

Report—

the selected test, which contains a set- -
up diagram. Connect the test equip-
ment as shown in the diagram.

4. If the AWG and DTG are used for the
selected test, select Signal Sources
and configure the test equipment. For
more information, see the remote con-
trol procedure on pages 32 through 35
of this document, or refer to the online
help.

Sink-> Jitter Tolerance Clock-» Ch1; Data-= ChZ; Rec Length -> 1M; CRU - PLL; Freq Pair-= D, Ck:S00KHz, 10MHz

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Use the HDMI Software

View the Waveform

1. Click View Waveform (not applicable
for all tests).

2. Verify that the waveform in the upper
part of display is similar to the wave-
form that is displayed in the TDSHT3
software.

If the displays are not similar, check
your configuration and connections.

Run the Test

1. Click Run Test.

2. The test will run, displaying a progress
indicator.

Horiz/Acq

Trig Display Cursors Measure  Masks Math Utilities Help

View Waveform

Configure

L
Selact { o signal(s) as shown. Click Mbra for dataiis. :‘”S“t
.
4 i ] i Result

Vic
Wavetorm |

Dretail

Source - InterPair Skew(D.D) Data A-* Chi; Data B-» Ch2; Thit 1 3503 ns

File Tests Results Utilities Help

| x|

@

Result Summany: Source
Select

Status :

Configure
d Current Test :

Completed :
Connect

Wiy

Wiavaform betall

Gl

Source -> Eye Diagram Clock-> Chi; Data-» Ch2; Rec Length -> 1M; CRU > PLL

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Use the HDMI Software

Interpret the Test Result

12

1.

When the test completes, the Result
Summary appears. Check to see if the
device passed the test.

means Pass
El means Fail
[l means Error

If the device did not pass the test, use
steps 2 through 8 to solve the problem,
and then rerun the test.

Click Result Details for a spreadsheet
with details about the test result.

Check the Remarks column. If any er-
ror codes are present, see the online
help for error code descriptions.

File Tests Results LUtilities Help

Result Summany: Source
Test Mame

L /17-10: Data Eye Diagram: CK, [
Configure o o

Connect

Wiy
ifaweform

Source -= Eye Diagram Clock-> Ch1; Data -» Ch2; Rec

NOTE. The parameters in the Result Details dialog box may change depending on the test that you run.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Use the HDMI Software

If you ran an eye diagram test, a plot
appears. You can do the following:

4. Save the image to
C:\TekApplications\TDSHT3\Images -
(you can also change this path). [A—"

Mask Movement
Fine

5. Zoom in and out. : = ; :

Rezef ‘
u .
Results

Mask Test

Mask Hits 0

6. View the histogram.

[1&7mY £ div ]

7. Move the mask to see the margin of
error.

Vswing  952.00mV
Thit 1.3482ns

= Voltage

Data Jitter 187ps

8. View statistics.

Hist Pk-Pk  187ps

9. Change the plot to half screen size
(which returns the Result Summary).

10. A plot also appears if you ran the clock
jitter test. In this plot, you will find the
peak-to-peak jitter of the clock. Clock Jitter

Results
Result
Pk-Pk 97.6ps
Vswing  932.40mV¥

Valtage [163mv ) div]

Thit 1.3482ns

-

ITPk-Pk 124.12ps

Hist Pk-Pk  97.6ps

= Time [138psidiv]
alt Screen

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 13



Use the HDMI Software

Generate and Print a Report

You can generate and print a summary or detailed report as described here.

You can also use the Report Generator to create and print customized reports. You can save files as RTF, or in custom file
formats such as RGT, RPL, and RPT. For more information about the Report Generator, see online help.

Summary

After you have successfully run a test or tests, you can generate a report summary as a .csv file.

1. CI|Ck Summary in the execution pane. File Tests Resulis Utilities Help TDSHT3 L

Result Summany: Source Report Configuration

2. A message indicates where the report Select
summary is saved. e - been mve =3
3. Open the file and print the report. R - &l @

Wiy
Wi aveform

Source -» Eye Diagram Clock-> Chi; Data-» Ch2; Rec Length -> 1M, CR

14 TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Use the HDMI Software

Detail

After you run a test, you can generate a report that contains default information or information that you configure.

1. Click Result to begin configuring the
report (or skip to step 14 for defaults).

2. Select the input on which you con-
ducted the test.

3. Enter the resolution at which you con-
ducted the test (such as 40 Hz, 43 Hz,
57 Hz, or 60 Hz).

4. Enter the refresh rate at which you
conducted the test (such as VGA,
SVGA, XGA, or SXGA).

5. Note the location where the report will
be saved; you can change the location
if desired.

6. Select Enable Preview to view the re-
port on screen when the report is gen-
erated.

7. Click Clear Report to clear all reports.
Reports generated between this and
the next successful test run will have
no values.

8. Click Advanced.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Resolution 18:

Refresh Rate B0OHz

Report File
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Use the HDMI Software

16

9.

10.
11.

12.

13.

Enter the DUT ID (serial number).
Enter the DUT details (product type).

Enter the pair(s) that you are using for
single-ended and differential tests.
These entries correspond to the con-
nectors on the HDMI adapter; see the
setup diagrams.

When this check box is cleared, the
TDSHTS3 software configures the oscil-
loscope to display jpeg images in re-
ports.

If you want to change the default
image export settings, change the
settings in the oscilloscope image

export setup and check this check box.

Click OK.

Report Configuration Advanced...

Device 10 TDSHTZ 004

Device Details  HEMI Device |

Pair {Single-Ended}) I [ atadl

® @6

Pair {0, O) | Datal- Datad

dlzettings for image export

Cancel

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Use the HDMI Software

14. Click Detail in the report pane to gen- 13|
File Edit “iew Object Help
erate the report. L LRI e A
= |

] If Enable PreView |S Se|eCted, the Test ID/Name: 7-10: Data Eye Diagram : CK, D

Report Viewer Utlllty displays the Spec Hange : Data Jitter < 0.3"TEit;
report. Otherwise, a dialog box Wiesp Yalueg RATRESTE

Fesult : Pase

displays the location where the
report was saved.

= For an eye diagram or clock jitter
test, a plot is also displayed.

= You can use the Report Viewer
Edit menu to edit the report, if

"
desired. Thit 1.0000ns
Vewing :  WeD = 864.48mV

m  Use the Report Viewer File menu - | ,
to print the report or export the Resdly o e
report to an RTF file.

NOTE. The report details are real time and no history is maintained. Save the report details before making another test.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 17
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Application Examples

Source: Select All (Clock-Data Tests)

This selection runs a set of tests simultaneously.

Required equipment Example

2 differential probes; Ground lead Tektronix P7330 or later; Tektronix 196-3469-00
1 DC power supply, setto 3.3V Kenwood PW18-1.8AQ

1 EDID emulator Silicon Image TE9100

1 input adapter Tektronix TPA-P-DI

Probe Calibration and Deskew fixture Tektronix 067-1478-xx

1. Click Select. @

2. Click the Source tab. File [ests Results |Utiities Help TDSHT3 | x|
i ‘ i d Run
3. Click Select All. et - S tnde foss
- gram & iter-P .Inlrs-F‘au Shewn
-
Ri

Source -> Mo Tests selected Select any test to continue

Flle Tesls Fesult: Umlde: Help

Source -» Mulliphe Tests

4. Click Configure. Change these values File Tests Ryp Utilities Help TDSHT3 | x|
if needed. (You can generally use the o Canfiqure - Saurce
-Selecl

Clogk-» Chi; Data > Ch2: Rea Langth-» 188

Al Horizieq Reference Levels
default values.) Clock HofAcgs & i Test
Ch1 A0k * &
Data ji
Chz W ReclBen ot - Report—
Mo <
CRU
Wian 20%
[
Source -> Multiple Tests Clock-> Chi; Data-» Ch2; Rec Length -> 1M; CRU -> PLL; High -> 20%; Low > 20%
5. Click Connect. File Tests Results Utilities Help TDSHT3 _%] X

Connect

Follow these instructions to set up the connections.
e

- b - fare
(5
De setup e ke
Report—|
2 Setup the DUT.

SUmman

Wiewn )
Wiavaform | MR

Source -» Multiple Tests

18 TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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6. Connect and configure the equipment:

= Connect the test equipment as
shown in the setup diagram.

= Configure the source DUT to
output the first supported video
format.

= Configure the EDID Emulator for

the required resolution (refer to the

EDID Emulator user manual).

7. Click View Waveform.

Verify that the oscilloscope displays a
similar waveform to the one displayed
by the TDSHT3 software. If the
displays are not similar, check your
configuration and connections.

Digital Oscilloscope

EDID Emulator

Source DUT

00-00
o

File Edit Werkical Horiz/Acq Trig Display Cursors Measure  Masks Math Utilities Help

e e ]
| L

el mend

PPttt

File Tests Results Utilities Help TDSHT3

| ]

View Waveform

Select Waveform skoufd iook like the signal®) as shown. Click Mbra for datails.| Mo
— '  S—

Configure
Connect
Wigm
W awetarm

Source -* Multiple Tests

Result

Summary
Detail

Clock-= Ch1; Data-» Ch2; Rec Length -» 8k; CRU-> PLL; High -» 80%; Low -> 20%

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 19
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To ensure accurate results, deskew the
probes before you run a test.

8. Click Connect.
9. Click Deskew.
10. Set the parameters as follows:

m  Select Internal source for this
example.

= Verify that the From channel is set
to Ch1 (reference point).

= Verify that the To channel is set to
Ch2 (channel to be deskewed).

11. Click Run Test to deskew the probes.

12. When deskew completes, click Run
Test to run the test.

13. When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 12.

14. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 14.

15. After you test the Data0 input pair,
move the probe from Data0 to Data1
and repeat the test. Repeat for Data2.

16. Configure the EDID Emulator for the
next pixel clock rate (VGA, SVGA, and
so on), and test for all three data input
pairs. Only one video format is re-
quired per pixel clock rate.

17. Repeat step 16 for all supported pixel
clock rates.

20

File Tests Results Utilities Help

TDSHT3 m x|

Connect

Select Follow these instructions to set up the connections.

Source -» Multiple Tests Clock-» Ch1; Data-» ChZ: Rec Length -» 1hi; CRU-* PLL: High -» 80%.; Louw - 20%

Deskew

0

File Tests Results Utilities Help

Source

From Input Setup
Input Hysteresis #  RefLevel
L

Ch1 =

Configure

Internal

Report—

Connect To Input Setup

Input Hysteresis #  ReflLevel
.

Wi Chz W
Wi aveform

Hilities -> Desken

File Tests Resulis UtilitiesT Help

Result Summary| Source

Selest asTHame
Ll ot DvernaoT Ny |

Click Run Test to Deskew the probes.

Connect

Wiew
Wiawetorm

Source - Multiple Tests

TDSHT3 HDMI Compliance Test Software Quick Start User Manual

Clock -» Ch1; Data-= Ch2; Rec Length -» 8k; CRU -> PLL; High -> 80%; Lo . > 20%;

Summary

Pair {CK, D}

Resolution

Report—|

Refresh Rate

Report File

g Enable P
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Source: Inter-Pair Skew (Data-Data Tests)

This test verifies that the skew between the differential pairs in the TMDS portion of the HDMI link is within the limits

stated in the HDMI Specifications.

Required equipment

Example

2 differential probes; Ground lead

Tektronix P7330 or later; Tektronix 196-3469-00

1 DC power supply, setto 3.3 V

Kenwood PW18-1.8AQ

1 EDID emulator

Silicon Image TE9100

1 input adapter

Tektronix TPA-P-DI

1. Click Select.
2. Click the Source tab.

3. Select Inter-Pair Skew.

4. Click Configure. Change these values
if needed. (You can generally use the
default values.)

5. Click Connect.

@

File [lests Results Ltilities Help

TDSHT3 | X
_Select - Source

i Cable Run

Clock-Data Tests Dat:
In

Select

ter-Pair
Configure

Connect

e
Wian - o
i awatorm = 1har Select Al

Source -» InterPair SkevaD,D)  Data A-» Ch1; Data B-> Ch2; Clock-= Ch1; Thit Recale; Avgs -= 100

File Tests Re Utilities Help
Configure - Source
Horizifcq

4 Reference Levels
Data A Hof Acgs High
{3

TDSHT3

Run
Test
&
Ch1 e
Data B f

Configure

Chz w Thit Report—

——
Clock caloulate 100

ch1 W
Miew Existing
Wi aveform Lzlue

Source -» InterPair SkevaD,D)  Data A-» Ch1; Data B-> Ch2; Clock-= Ch1; Thit Recale; Avgs -= 100

Connest Summany

Connect
Select llow these instructions to set up the connections.

Connectthe

Run
Test

Report—

Configure

Summary

Wiew

Wi aveform

Source -» InterPair SkevaD,D)  Data A-» Ch1; Data B-> Ch2; Clock-= Ch1; Thit Recale; Avgs -= 100

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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22

6. Connect and configure the equipment:

= Connect the test equipment as
shown in the setup diagram.

= Configure the source DUT to
output a video format with the
highest supported pixel clock
frequency.

= Configure the EDID Emulator for
the required resolution (refer to the
EDID Emulator user manual).

7. Click View Waveform.

Verify that the oscilloscope displays a
similar waveform to the one displayed
by the TDSHT3 software. If the
displays are not similar, check your
configuration and connections.

Digital Oscilloscope

EDID Emulator

s ;
DAT:"SN

~
R

DATAI

g 00 Y

<
v
> K

®,
 DATA? ||

TPA-P-DI

3|

File Edit Werkical Horiz/Acq Trig Display Cursors Measure  Masks Math Utilities

View Waveform

Waveform siould look like the siqnal&) as shown. Click Mbre for details.| More

nnnnn

Source - InterPair Skew(D.D) Data A-* Chi; Data B-» Ch2; Thit 1 3503 ns

Source DUT

Help

Summary
Detail

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Recalculate the Tbit value:

8. Click conﬁgul’e agaln ¢ Tests Results Utilities Help

Configure - Source

9. Check that the software is set (default) seict | . o ot me m st

to recalculate the Thit value. " D*: B'
10. If your signal has too much jitter an = o S
0. If your signal has too much jitter and o rormac ¥ summen

noise, increase the value in this box
(default = 100).

Ch1 W

Miew Existing
Wi aveform Value s

11 . C||ck Run Test and 1hen chck con“n- Source -» InterPair SkevaD,D)  Data A-» Ch1; Data B-> Ch2; Clock-= Ch1; Thit Recale; Avgs -= 100
ue to run the test with the new Thit val-
ue.
12. When the test completes, check the
test results. For more information, see @
Interpret the Test Result on page 12. File Tesls Resulls Uitz Help wsHTa || X |

Report Configuration

13. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 14.

= i Run
Pair {CK, D} atal il e
L7 -6: Inter-P air Skew: D, D

Resolution 18 oi i
_' Refresh Rate port—|

Conneot
3 Report File ) 15
Wieu
i avatorm iial i Enable

Source -3 Inter-Pair Skew(D D) Data A-» Chi; Data B-> Ch2; Clock-» Ch1; Th

scale; Avgs-> 100
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Sink: Min-Diff Sensitivity Test

This test verifies that the sink device properly supports TMDS differential voltages at minimum levels.

24

Required equipment

Example

Digital Timing Generator

Tektronix DTG5274 with DTM30 output module

8 SMA cables

Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters

1 DC power supply, set to 5.0 V

Kenwood PW18-1.8AQ

1 input adapter Tektronix TPA-R-TDR
1. Click Select. @
2. Click the Sink tab. File [Tests Redults Utiities Help TDSHT3 L

3. Select Min-Diff Sensitivity.

4. Click Configure. Change these values
if needed. (You can generally use the
default values.)

5. Click Connect.

" Sink i Cable
e
Differential Tests Single-Ended Tests Test
ity -_I\ﬂer Tolerance . Intra-Fair Shew
Configure Result
Report—
Wiew

Waveform

Sink -> Min-Diff Sensitivity

Input-= Ch1; Wiem -> 2.0V

File Tests Results Utiliies Help TDSHT3 m| x

Configure - Sink

P DIG Run
elec — Outputs Test
2.0V

Clock Datad

Ch Pattern Path i e -
Configure A Result
9 CATektpplicationd]
Data1 Data2 Report—
Wiew o
Wavatorm

B2 W ch -
Sink -> Min-Diff Sensitivity

Input-= Ch1; Wiem -> 2.0V

File Tests Results Utiliies Help TDSHT3 m| x
Connect

Follow these instructions to set up the connections.

1.8

Wiy
Wi aveform

Sink -> Min-Diff Sensitivity

Input-= Ch1; Wiem -> 2.0V

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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6. Connect and configure the equipment: DTG5274
C D
= Connect the test equipment as R @
shown in the diagram. #
C) [eele]e)

= Connect the DTG and oscilloscope Power Supply

according to the Enable Remote
Control of Test Equipment
procedure on pages 32 through 35.

[es)en]enYanlan]
oo oo |
oo ool O

© © © © J

Sink DUT

7. Click Run Test.

8. Follow the series of on-screen mes-
sages.

Report Configuration

Pair (CK, D) Data0

9. When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 12. fiefresn Rate

Report File

Resolution 14;

10. To generate reports based on the tests _ —
that you ran, see Generate and Print a ; erplot | | Evepiot | | patals | | [ Enatle?
RepOft on page 14. ff Sensitivity Input-> Ch1; VMiem -2 3.0%

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according
to the procedure on page 34.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 25



Application Examples

Sink: Jitter Tolerance Test

This test verifies that your device supports the maximum allowed TMDS clock jitter.

Required equipment Example
Digital Timing Generator Tektronix DTG5274 with DTM30 output module
Arbitrary Waveform Generator Tektronix AWG710 or AWG710B
12 SMA cables Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters
1 cable emulator JAE DC1P19ST02700AA for 27 MHz tests
JAE DC1P19ST07425AA for 74.25 MHz tests
2 bias tees Mini-circuits ZFBT-4R2GW
1 DC power supply, setto 5V Kenwood PW18-1.8AQ
2 input adapters Tektronix TPA-R-TDR
Tektronix TPA-R-DI

1. Click Select. @ @
2. Click the Sink tab. File Trests Resufts Utiities Help TDSHT3 | x|

elec
ial Tgs Single-Ended Tests Test
-r--||r.-[a|n Sensitivity itter Tolerance .Inlrs-F Sheeim
Configure Result
Report—

Wiy
Wi aveform

Sink-> Jitter Tolerance Clock-» Ch1; Data-= ChZ; Rec Length -> 1M; CRU - PLL; Freq Pair-= D, Ck:S00KHz, 10MHz

3. Select Jitter Tolerance.

4. CI|Ck conﬁgure. Change these values File Tests Re Utilities  Help TDSHT3 L
I Configure - Sink
if needed. (You can generally use the — o T
default values.) Clock Horizifeq RefLevel Units _ High Ref 1=

Ch1 W Rec Length
Configure Data Ty Result

Chz w Mid Ref Report —

Frequency Pair 10% 0%
-:onnect 0%
D,CkS00KHz,1... ¥

Low Ref
Wiew CRU DUT ErealMHz)y
i awatorm FLL ¥ 7425 ¥

Sink-> Jitter Tolerance Clock-» Ch1; Data-= ChZ; Rec Length -> 1M; CRU - PLL; Freq Pair-= D, Ck:S00KHz, 10MHz

5. Click the DTG tab and configure which @
DTG outputs will provide the clock and Hie Toss Resute Uilies Hen
data input signals. ; ———

TDSHT3 L
Run
DTG
Outputs
Clock Datal

Bl Bl v Report—

Pattern Path

CTel plications

Datal Data2

R ol v

Sink-> Jitter Tolerance Clock-» Ch1; Data-= ChZ; Rec Length -> 1M; CRU - PLL; Freq Pair-= D, Ck:S00KHz, 10MHz
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6. Click Connect.

Select

Configure

Sink-> Jitter Tolerance

7. Connect and configure the equipment:

= Connect the test equipment as
shown in the setup diagram.

= When connecting the test fixture to
the DUT, use a cable emulator
specified for the pixel clock rate
being tested.

File Tests Results Utilities Help

Connect

Follpwthese instructions to set up the connections.

| x|
et
Result

Summary
Detail

TDSHT3

Clock-» Ch1; Data-= ChZ; Rec Length -> 1M; CRU - PLL; Freq Pair-= D, Ck:S00KHz, 10MHz

DTG

ooooo
ooooo
ooooo

Qngond Oo 0

—
®

= Connect the DTG, AWG, and
oscilloscope according to the
Enable Remote Control of Test
Equipment procedure on pages 32

through 35.

(i) e [@)
oo|sBog
o g oo

[elo]elele]
[elelelole)
OO0 OO
[lelelele)
OO OO

—_
o

M2

=
9

= Configure the DUT to receive the
HDMI input signal.

7
B
A
3
o g

©

CH1

Bias Tee

CHI

Power Supply

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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8. Click Run Test.

9. Follow the series of on-screen mes-
sages.

10. When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 12.

11. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 14.

File Tests Results Utilities Help TDSHT3 m x

Result Summang} Sink Report Configuration
Fun

Name Pair (CK, D} | S Test

' Bl8-7: Clock Jitter: CK
| Blde7: pata ditter ci D Resolution 1 [ i

Refresh Rate B port—

Connect
Report File it

view | | I o
| Wavefor | [E Enable Preview il

Sink-= Jitter Tolerance Clock-» Ch1; Data-» Ch2; Rec Length -> 10; CRU -> PLL; Freq Pair-= D,CK: 500kHz 10MHz

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according

to the procedure on page 34.

28
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Cable: Eye Diagram Test

This test verifies that the cable assembly outputs a compliant data eye.

Required equipment

Example

Digital Timing Generator

Tektronix DTG5274 with DTM30 output module

2 differential probes; Ground lead

Tektronix P7330 or later; Tektronix 196-3469-00

8 SMA cables

Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters

1 DC power supply, setto 3.3 V

Kenwood PW18-1.8AQ

2 input adapters

Tektronix TPA-P-DI
Tektronix TPA-R-DI
Tektronix TPA-P-TDR

1. Click Select.
2. Click the Cable tab.

3. Click Configure. Change the values if
needed. (You can generally use the de-
fault values.)

= Test Points. For the first cable that
you test, select TP1 and TP2 to
verify both the input test signal
(TP1) and the output of the cable
(TP2). For successive cable tests,
clear TP1.

= CRU. Ensure that PLL (default) is
selected for compliance testing.

4. Click the DTG tab. Configure which
DTG outputs will provide the clock and
data test signals.

File ests Results Utilities Help TDSHT3 E X
T Soures i m e -Run
elec
Differential Tests Test
Configure Result

Report—

Connect

Wiy
Wi aveform

Cable -> Eye Diagram

File Tests g Utilities  Help TDSHT3 L. T
Configure - Cable

< [ Setup LTe
Llack WELEL ] Ref Level Units ~ High Ref
Chl W Rec Length
Configur ; Per (%) ¥
D: Mo

Chz - Hystere: * Mid Ref

Test Points 25%
o1 [ ve2

CRU.
FLL ¥

Clock-> Chi; Data-» Ch2; Rec Length -> 1M; CRU -> PLL; TP1 -= true; TP2Z -> true

Low Ref

Cable -» Eye Diagram Clack-» Ch1; Data = ChZ; Reo Length -> 1hi; CRU -» FLL; TR1 -> true; TPZ -2 true

File Tests Results Utilities Help : TDSHT3 m| x

onfiqure - Cable

( Setup [ DTG ¢ Run
Outputs
Configure e e Result
Chz

Al W B1 ¥ Report—
Cennact Data1 Data2 Sumimary
g2 W= c1 -

D etail

Cable -» Eye Diagram Clock-* Ch1: Data-»* Ch2: Rec Length -= AM: CRU-» PLL: TP1 -» true: TP2 -» true

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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5. Click Connect.

6. Connect and configure the equipment
to verify the test signal input:

= Connect the test equipment as
shown in the TP1 setup diagram.

= Connect the DTG and oscilloscope
according to the Enable Remote
Control of Test Equipment
procedure on pages 32 through 35.

Select

Configure

File Tests Results Utilities Help

TDSHT3

| x|
Connect

7 these instructions to set up the connections. R
Test
o More

Result
1 Setup the DUT, test

Summary
Detajl

Cable -» Eye

Diagram Clock-* Ch1: Data-* Ch2: Rec Length -= AM: CRU -> PLL: TP1 -= true; TP2 -= frue

Digital Oscilloscope

Power Supply

TPA-P-DI

OO OoOol o

S !WHWWHWH\

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according

to the procedure on page 34.
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7. Click Run Test.

8. Follow the series of on-screen mes-
sages.

9. When the test completes, check the
test results. These results confirm that
the test signal input is compliant. For
more information, see Interpret the
Test Result on page 12.

10. Remove the TPA-P-DI adapter and add
the TPA-R-DI adapter as shown in the

diagram.

11. Add the cable DUT between the
TPA-R-TDR and TPA-R-DI adapters.

12. Click Run Test.

13. When the test completes, check the
test results. Pass indicates HDMI com-
pliance of the cable DUT. For more in-
formation, see Interpret the Test Result

on page 12.

14. Click Configure and set the test point

to TP2.

15. Replace the cable with another cable

DUT and click Run Test.

16. To generate reports based on the tests
that you ran, see Generate and Print a

Report on page 14.

Flle Tests Results Utilities Help

@

Report Configuration

Pair (CK, D) I Datald gt

Resolution

oooooo

ODOELE%

N

000 0"
& e el eXe)
(o cooJ(q/lg) O O -]

il 0i

TDSHT3 By

TPA-R-TDR

[———
oco|o_ [ @
oco|pBog

o d oo

[ole]elele)
‘ODODO‘D

000

[eleelee)
[elelelele)
[elelele)

—
o

S !mﬂmmuﬁw\g

CL
N

OCK_P

Y

A M

Power Supply
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Enable Remote Control of Test Equipment

If you are using the specified Tektronix DTG and AWG models, the TDSHT3 software can configure the connected test
equipment automatically as you run tests. If you are using another DTG or AWG, you must configure the test equipment
manually.

Use this procedure to:

= Connect the AWG and DTG for remote control
= Configure the GPIB address for remote control
You will need:

= Tektronix DTG5274, Tektronix AWG710

m  Tektronix 7000 series digital oscilloscope

= National Instruments GPIB-USB-B with the included software, NI-488.2 for Windows

Install NI-488.2 for Windows

NOTE. If you already have NI-488.2 installed on your oscilloscope, ensure that you have the version and installation
parameters that are described in step 1. If you do not, then uninstall NI-488.2, and install it according to step 1.

1. Install NI-488.2 for Windows (ver- @ o o
sion 2.1 or later). — ...
. . . )irr Selectthe features to be installed. i NI:D48°8.2
Dunng |nsta"at|0n: High Performance GPIB Software
Feature Description
. = = - N-4p8 2
2. Do not install NI-VISA. ' =2-| Driver and Aglizairs

53 -| GPIB Analyzer
£l & | Language Support
-2 | Microsaf C/CH
Buorland C/C++
53+ Wisual Basic

3. Install the Measurement & Automation
Explorer.

®

B | LabvIEW
- 23 +| LabWindows/CV|
4. When prompted, enable the GPIB- N
USB interface. 25 +| Measurement & Automation Explorer

5. Restart the oscilloscope.

®

Target Directory
[ Brovee |

DiskCost | scBack Next»>
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Connect the Equipment

6. Connect the USB-GPIB controller to @
the oscilloscope USB port. The oscillo- @
scope operating system detects the . SB
USB-GPIB controller and installs the GPIB Oscilloscope
driver for it. AWG [:,H = o‘ oorye
S ——»
7. Using GPIB cables, connect (stack) the ¥ ’ 0 BEABEEAEA
DTG and AWG GPIB connectors to the ® b—d o
GPIB port of the GPIB controller. [ ] JEHoOED b %L
If your test does not use the AWG, By EYYYr
connect the GPIB-USB-B between the Lo I =
oscilloscope and the DTG, omitting the
stacked connector from the AWG. DTG GPIB (Stacked @
: / connectors)
AR ===
=] ¢
g GPIB-USB-B
( {an),
J
- yom
B an
Verify the Equipment Connections
8. Open the Measurement & Automation
Explorer that was installed with the _
NI-488.2 software. e o 1 el
. . Propertles | “%Scan For Instrumen s | gNI Spy\/é Analyzer
9. In the Configuration pane, under De- = b T
vices and Interfaces, right-click the Tfton ' I bl
GPIB device. | 5PN Devices and Interfaces I':";sm e o Numherl ;a' & [
-uld SRRl (@] Instrumentn Primary Address ...  TEKTROMIX,DTGE5274,J300167
10. C|ICk scan fOI' Instruments. ___I%msuut:'gsz&ms Instrumentl Primary Address ...  SONYITEK,AWGT10,0,5CPT:99
11. Note the GPIB Instrument Number and q &
the Primary Address. i I3 | Avibuies

4

12. Right-click the instrument and click
Communicate with Instrument.

13. Click Query and check that *IDN? de-
scribes the correct equipment.
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Set the GPIB Bus Timing

14. Right-click the GPIB device and click
Properties.

15. Click the Advanced tab.
16. In the Bus Timing list, select 2usec.

17. Click OK. (Be sure that you complete
the procedure through step 28, where
you will exit the software and restart
the oscilloscope.)

Configure the GPIB Address

18. Start the TDSHT3 software.
19. Click Select.
20. Click the Sink tab.

21. Select a Differential test, such as Jitter
Tolerance.

34

¥ Measurement & Autoration Explorer X =10l x|
File Edit Yiew Took Help

J E&'Properties | 2, 5can For Instrumenks | H N spy 8, GPIB Analyzer

Configuration rz | GPIBO (GPIB-USB-B)

-:| tA My System

MName | Yalue | Description

- N Devices and Interfares | || [pggo 7o e m e
8 : ﬁg -Sﬁgftizlriu AEREHES ) Inskrumentd Primary Address ... TEKTROMIX,DTE5274, 1300167
@ Remote Systems Instrument1 Primary Address .., SONYITER,AWGT10,0,5CFT:99
i |
‘. I 2] | evivues |
v
29 GPIB Configuration d |
NI-488.2 Setings Advanced |
}7 GPIE-USEB
Bus Timing: ISDDnsec vl @
Zusec
Parallel Poll Duration: E00nsec
350nsec
Cable Length for H3488: Off hd
¥ Automatic Serial Polling
[~ Assert BEMN when SC
r QK—I Cancel
File Tests Results Utiities Help HDMI Utilityv0.6.3 | B8 X

Select

—
Configure

Single-Ended Tests

Wiy Detail
etai
Wi aveform

Sink-> Jitter Tolerance Clock-» Chi; Data.» Ch2; Reec Length-= 16M; CRU-Clock-> PLL;
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22. Click Connect. File Tests Results Utiites Help HDMI Utility v0.6.3 | 8| | %

23. Click Signal Sources.

Select llow these instructions to conhect your setup.
@ Connect

Wiy
Wi aveform

Sink-> Jitter Tolerance Clock-» Chi; Data.» Ch2; Reec Length-= 16M; CRU-Clock-> PLL;

For the Tektronix DTG5274 generator:
24. Click the DTG tab. $ o6 | Awe @

25. Click GPIB. Select GPIE setup

26. Click the AWG tab and repeat. Board Type Address
GFIBOD W Primary

27. Click Test Conn and look for a mes- P
sage that the connection is successful.

28. Exit the TDSHT3 software and restart SIEHEIIIRT

the oscilloscope. @ o
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Address, Tektronix, iv
Advanced, 15

APP button, 8
Application examples, 18

Cable tests, Eye Diagram, 29

Sink tests
Jitter Tolerance, 26
Min-Diff Sensitivity, 24
Source tests
Inter - Pair Skew, 21
Select All, 18
AWG setup, 32

Buttons, 5

C

Cable, Eye Diagram test, 29
Cable emulator, 27

Calibrate probes, 3

Clear report, 15

Client pane, 5

Close the application, 4
Configure, 10

Configure button, 9
Configure test equipment, 32
Configure the GPIB address, 34
Connect, 10

Connect button, 9

Connect test equipment, 32
Connections, 1

Contact Tektronix, iv

CSV file, 14

D

Deskew, 20

Detail, 17

Detailed report, 15
Device under test type, 5
Documentation, iii

DTG setup, 32
DTG5274, 35

DUT Details, 16

DUT ID, 16

DUT type, 5
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E

Edge trigger, 7

EDID emulator, 20
Enable Preview, 15, 17
Error codes, 12
Execution pane, 5

Exit button, 4

Exit the software, 4

F

Factory defaults, 10
File
Exit, 4
Preferences, 7
Run application, 2
Fine button, 7

G

General purpose knob, 7, 10
Generate a report, 14

Generator setup, 32

Get acquainted with the application, 5
GPIB, 35

GPIB address, 34

GPIB bus timing, 34

H

Half Screen, 13
HDMI standards conformance, iii
Hide icon, 8
Hide the application, 8
How to
Install your software, 1
Make tests, 9
Operate the Application, 9

Installation, 1

Inter - Pair Skew test, 21
Interface, 5

Intersymbol interference, 7

J

Jitter Tolerance test, 26

K

Key features, iii
Keyboard, 5
Knob, 7, 10

Make tests, 9

Menu bar, 5

Menus, 5

Min-Diff Sensitivity test, 24
Mouse, 5

Multiple tests, 9

NI-488.2 for Windows, 32

0)

Oscilloscope general purpose knob, 10

P

Pair, 15

Pixel clock rates, 20

Position eye mask in center, 7
Preferences, 7

Print a report, 14

Product description, iii
Product support, iv

R

Recalculate Thit value, 23
Refresh Rate, 15

Related documentation, iii
Remote control, 32
Report File, 15

Report file formats, 14
Report summary, 14
Resolution, 15

Restore application, 8
Result Details, 12
Results, 12

Results button, 9

Return to the application, 8
RGT format, 14

RPL format, 14
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RPT format, 14
RTF format, 14
Run Test, 11

Run Test button, 9

S

Select button, 9

Select All, 9, 18

Select multiple tests, 9

Selection pane, 5

Service support, contact information, iv

Set preferences, 7

Signal Sources, 35

Sink, Differential
Jitter Tolerance test, 26
Min - Diff Sensitivity test, 24

Software upgrades, iv

Source, Data-Data, Inter-Pair Skew
test, 21

Source tab, 9

Source tests, Select All, 18

Start the application, 2

Status bar, 5

SVGA, 20

T

Thit value, 23

Technical support, iv

Tektronix, contact, iv

TekVisa, 1

Test Conn, 35

Test equipment, 32, 33
Connect, 10
Setups, 1

Test D, 9

Test ID 5-3, 29

Test ID 8-5, 24

Test ID 8-7, 26

Test parameters, Configure, 10

Test results, 12

Tests, Process flow, 9

Touch screen, 5

TPA-P-DI, 1

TPA-P-SE, 1

TPA-R-DI, 1
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TPA-R-SE, 1
TPA-R-TDR, 1
Trigger, 7

U

Use oscilloscope settings for image
export, 16
Use the interface, 5

vV

VGA, 20

View test results, 12
View Waveform, 11

View Waveform button, 9
Virtual keyboard, 5, 10
Virtual keypad, 6

w

Web site address, Tektronix, iv
Width trigger, 7
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